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How to Get Started

This game is written as a MDI application.    The game main window is divided into many child windows.    
Each of the child windows (Strategic, Tactical, and Ship Status) is moveable and resizable.    The 
Strategic window is used to give the player an overall view of the quadrant.    The buttons represent the 
sectors of a quadrant.    The Tactical window is the close-up view of a sector.    The Ship Status window 
displays the current status of the player's ship.

The menu commands are different depending on the currently selected child window.    For instance, to 
use the Strategic Scan command the player must first select the Strategic windows as the active window. 
Then the Control menu option will change to reflect the commands available for the Strategic window.    
Each window has different Control commands.

Most of the menu commands have an accelerator keyboard command.    For example, the Strategic Scan 
command can be invoked by the "C" key.    The accelerators are listed to the right of the menu command.



How to Use Main Window

Please click left mouse button on parts of window to receive help.



Toolbar

The toolbar is a collection of buttons that will invoke certain menu commands.    The toolbar is designed to 
make it easier to perform the commands.    Following is the meaning of the buttons:

 This button will perform the Strategic Scan Command.

 This button will perform the Strategic Game Status Command.

 This button will perform the Ship Status Repair Command.

 This button will perform the Tactical Launch Wild Weasel Command.

 This button will perform the Tactical Dock Command.

 This button will perform the Tactical Orbit Command.

 This button will perform the Tactical Stop Command.



Message Line

The message line is used to communicate with the user.    Simple help messages are written into the 
message line when a toolbar button is pressed or a menu option is selected.    Also, miscellaneous 
messages are written in the message line during the playing of the game.    The message is erased after a 
few seconds.



How to Use Strategic Display

The player starts out a game in sector 0,0 (upper left corner of the Strategic window).    The button is 
depressed indicating the current sector being displayed by the tactical window.    The Sector Color Code 
for the sectors indicates the contents of the sector.    The player can use the Strategic Scan command to 
scan the sectors next to the current sector.    To move to another sector, the player presses the button of 
the sector to warp into.    A maximum of two sectors can be warped at a time.



How to Use Tactical Display

The Tactical window uses the mouse to control the player's ship.    The left mouse button is used to 
activate the Tactical Popup menu.    The player places the cursor over the object to be acted upon.    Then 
the right mouse button is pressed.    The player then selects the command to be performed on the object. 
For example, clicking the right mouse button on an enemy ship and then selecting "Fire Phasers" will fire 
the phasers at the ship.    The player may also interact with some background objects such as a starbase 
from the tactical display, for example.



How to Use Ship Status Display

The Ship Status window contains the current status of the systems for the player's ship.    The status is 
constantly updated.    The player may change the order of the systems being repaired by using the Ship 
Status Repair command.    For example, if the player wishes to have the warp engines repaired, the 
player would select the "Repair" command.    The "Warp Engine" button is then selected to be repaired 
next.



Background Objects

Background objects are seen on the Tactical Window.    They are objects contained in the current sector. 
The player can interact with some of the objects.    Following is a list of the objects:

    This is a starbase.    The player can dock with it.

    This is a gaseous planet.    The player can orbit it.

    This is a Type-M planet.    The player can orbit it.

    This is a nebula.

    This is an asteroid belt.

The number of starbases and planets can be displayed from the Strategic Game Status command.



Copyright and Licensing

Copyright © BFM Software 1992, 1993
Copyright © Brett McDonald 1992, 1993

Following are the system requirements:
1) 286 or higher processor
2) Windows 3.1 or higher
3) Mouse or other pointing device
4) Color monitor - High SVGA resolution recommended.

This game is shareware.    This game is NOT free.    If you like the game and continue to use it, you MUST 
register the game.    Registration    Fee: $12.95 U.S.

BFM Software
Brett McDonald
38602 Lancaster Drive
Farmington Hills, MI 48331

To receive a disk with the latest version add $4.00 to the registration fee.

Following are our BBS IDs:
Compuserve ID - 73770,1254
American On-line ID - BrettMc

We are a member of the Compuserve Shareware Registration system.    You may 
register BFM Software products with Compuserve.    They will add the fee to 
your bill and we will send you the registration.    To access this system 
enter "GO SWREG".    Select Register Shareware.    Then search for the keyword 
"BFM" to find all BFM Software products.

Please include your name EXACTLY as you want it registered and the generated 
key from the registration dialog box.

You may distribute this software as long as the following files are included:
WTREAD.TXT
WT.EXE
WT.HLP

All the above files, must be combined into a single file ZIP or other compression format for distribution.

Beyond a fee for the reproduction and media cost, no fee may be charged for distribution of this software.

This software claims no warranty, implied or otherwise.    This software is provided "AS IS".    The author 
claims no responsibility for any damages that might be caused by the use or abuse of this software.    This 
software remains the property of the author.    This software may not be modified in any way.



Registration

Note: To print this registration form select FILE then PRINT TOPIC from menu.

Win Trek Registration Form

Version: ______

Name to be registered: _________________________________

Generated key: __________

Ship to address: ____________________________________

____________________________________

____________________________________

____________________________________

Please send check or money order for $12.95.    To:
BFM Software
Brett McDonald
20278 Old Homestead
Harper Woods, MI 48225



Game Storyline

Stardate 44421.3 -- the Romights have successfully convinced your ally the Klinions to join them in 
eliminating the UP from the universe.    You, of course, are not going to let that happen.    The Fergans 
have also joined the war against you.    Your mission is to defeat them as quickly as possible.    As always, 
be very careful when coming across the Borbans.    You must rid this quadrant of enemy forces by 
yourself.    All other forces are busy fighting in other quadrants around the universe.    Good luck!    The 
fate of the universe depends on your being able to win this battle.



Game Levels

This game can be played at different levels.    The three levels are Beginner, Normal and Advanced.    
Below are the descriptions of the levels:

Beginner
This level is designed for new players.    It is very easy and not very challenging.
* The ? Command bubbles are automatically displayed at the beginning of the game.
* The player gets less photon torpedoes.
* The phasers recharge slower.
* There are fewer sectors are in the quadrant.
* There are fewer enemy ships in the quadrant.
* Natural disasters happen less frequently.
* Enemy ships fire slower with less force.
* The player's score is penalized.
* One less Wild Weasel Shuttle is supplied.

Normal
This level is designed for a moderately paced, somewhat challenging game.

Advanced
This level is designed for players wanting a challenge.    It is very fast paced.
* The player gets more photon torpedoes.
* The phasers recharge faster.
* Many sectors are in the quadrant.
* Many enemy ships are in the quadrant.
* Natural disasters happen more frequently.
* Enemy ships fire faster with more force.
* The player's score is enhanced.
* One more Wild Weasel Shuttle is supplied.



Natural Disasters

Natural Disasters are just a few of the situations starship captains must deal with.    The situations are 
very random and are not predicable.    They are just a "fact of life" while being in space.

Some natural disasters will cause damage to any ship in the sector.    Ships that are docked will be 
protected by the starbase's shields.    Ships in a planet's orbit will be protected by the atmosphere.    It is 
also thought that a cloaking device gives protection, although, this is unconfirmed.    These types of 
Natural Disasters can either work for or against a player.    If the player's ship is very damaged, it could 
finish the player off.    On the other hand, it will damage all the other ships in the sector the player is trying 
to defeat.    Super Nova Bursts and Ion Storms are examples of these.

Other natural disasters do not cause damage to a player's ship.    They just make it more difficult to keep 
control of the ship.    They move the ship to another location in the quadrant or sector.    These natural 
disasters can also work for or against a player, depending if the player wants to be moved away or near 
an enemy ship.    Worm Holes and Subspace Wrinkles are examples of these.



Races of Universe

The universe is made up of many different races.    Following is a map of the universe with the location of 
the different races' territories:

The United Planets (UP) is the race of the player of Win Trek.    The UP are a peaceful and noble race.    
They had eliminated war for over one hundred standard years.    They had even become allies with the 
Klinions, who later betrayed them.    The UP is made up of over 1000 planets.    The territory of the UP is 
as large as the other races combined.

The Romights are a brutal race.    They have created their empire by death and destruction.    They are set 
on taking over the UP.    The Romights have been at war for over 1000 standard years.    During this war, 
they have become a race of expert soldiers.    They are very powerful and will not be satisfied until the 
entire universe is theirs.

The Klinions are a fearless race of warriors.    They were once an ally of the UP.    Many years of 
friendship turned into mistrust.    The Romights approached them with their plans to attack the UP.    The 
Klinions turned on the UP.

The Fergans are a race of intergalactic mercenaries.    They are very untrustworthy.    They are being paid 
by the Romights to fight the UP.    The Fergans are not very intelligent.    They entered the war for the 
money.

The Borgans are the most dangerous of all races.    They are not at war with the UP.    The Borgans will, 
however, try to destroy any ship that gets in their way.    The Borgan ships are the most powerful in the 
universe.    Beware -- the Borgans don't have a word for mercy in their language!



Scoring

Win Trek keeps track of the player's score throughout the game.    Every time an enemy ship is destroyed, 
the player's score is incremented.    The current score can be displayed from the Strategic Control Status 
command.    The dialog box displayed will contain the current and high score for the player.

Scoring values are as follows for destroying objects:

Object Score Description

50 Armageddon Class Ship

10 Executioner Class Ship

7 Marauder Class Ship

5 Bird of Prey Class Ship

1 Plasma Torpedo

The score is multiplied by the game level.    The levels are beginner - one, normal - two, and advanced - 
three.    For example, if an object's score is 5 and the player's level is normal the total score for destroying 
the object is 10.

Certain things cause the player's score to be decreased.    They are as follows:
* Launch Wild Weasel - decrease by 100.
* Sensor Overload - decrease by 300.

A bonus is given to the player for destroying all enemy ships in the quadrant.    The bonus is based on the 
time taken to complete the game.



Sector Color Code

The Sector Color Code is the code for the notches in a scanned sector on the Strategic Display.    Below 
is an example of a sector display followed by an explanation:

The gray button on the left is an unscanned sector.    The bottom of the window has the color code as 
follows:

Star - Starbase
Exe - Executioner class ship,
Arm - Armageddon class ship
Bird - Bird of Prey class ship
Mar - Marauder class ship.

For example, the second from the left button indicates that at least one Starbase, Executioner, 
Armageddon, and Bird of Prey is in the sector.    More than one of a class could be present in a sector.



Ships

Each race has its own ship class.    They are all different in appearance and capabilities.    Below is the 
information on each ship:

Class: Galaxy
Race: UP
Weapon: Phasers and Photon Torpedoes
Speed: Fast
Shields: Strong
Hull: Thick

This ship is an all around performer.    It is very large and heavily armored.    It is fast and very well 
designed.    It will serve the player well.

Class: Executioner
Race: Romights
Weapon: Plasma torpedo
Speed: Average
Shields: Average
Hull: Average

This ship is large and difficult to destroy.    It has no direct fire weapons.    The plasma torpedoes are very 
dangerous up close.    It has strong shields.    It has a cloaking device that makes it impossible to fire upon 
it while cloaked.

Class: Marauder
Race: Fergan
Weapon: Tractor Repulsor Beam
Speed: Slow
Shields: Average
Hull: Average

This ship is large and slow moving.    The TR Beam has a long range.

Class: Armageddon
Race: Borgan
Weapon: Neutron Beam
Speed: Fast
Shields: Very Strong
Hull: Very Thick

This ship is large, fast and has strong shields.    The Neutron Beam has a long range and is powerful.

Class: Bird of Pray
Race: Klinion
Weapon: Disruptor
Speed: Very Fast



Shields: Weak
Hull: Thin

This ship is very fast.    It is faster than the Galaxy class ship.    It also has a cloaking device that will make 
it impossible for the player to fire upon it while cloaked.



Tips on Playing

This topic will give a few tips on how to play Win Trek.    The following are the tips:

Strategic Display
* The player should use Scan Command to view sectors before entering.    This will eliminate surprises.
* The player should move to every other sector and scan area.    This way the player can map the entire 

quadrant without entering every sector.    The player must remember that if the scanners are 
destroyed, all the sector displays will be reset.

Tactical    Display
* To defeat Executioner class ships - the player should obtain a safe distance and keep firing at them.    

The player must not get too close.    If a plasma torpedo is fired at close range, it will cause great 
damage.

* To defeat Plasma torpedoes - the player must run from them.    They deplete energy while moving.    
They can be fired upon to be detonated.

* To defeat Marauder class ships - the player should close range on them and fire while moving.    They 
are slow to fire.

* To defeat Armageddon class ships - the player must close in and attack right away.    The player must do 
the following:

1. Reload photon torpedoes at a starbase before attacking.
2. Fire photon torpedoes as fast as possible.
3. Try to keep enemy ships between him/herself and the Armageddon.    It will fire on the 

enemy ships giving the player extra time.
* To defeat Bird of Prey class ships - the player should ignore them.    They are fast moving but, have low 

fire power.    The player should dispose of them last and concentrate on attacking other ships first.
* The player can orbit a planet to hide from enemy ships.    The enemy ships cannot fire at the player 

while a ship is in orbit but, the player cannot fire either.
* The player can dock with a Starbase.    The Starbase will restock the ship with Photon Torpedoes.    It will 

increase the rate of repair on the ship.    It will also use its shields to protect the player's ship.
* The player should alternate between firing Phasers and Photon Torpedoes.    This will allow the Phasers 

to recharge while the Photon Torpedoes are being fired.
* A Sensor Overload is a last ditch option to get out of a bad situation.    This will destroy most of the 

player's ship though!
* Releasing a Wild Weasel Shuttle is a good way to get out of a critical situation.    The enemy ships will 

attack it and not the player!
* Try to get on the other side of a Nebula or Asteroid Belt.    The enemy ships will go through them to get 

to you.

Ship Status Display
* The player must use the Repair command to indicate which damaged system to repair next.    Damage 

control repairs systems in a certain order.    The order is listed on the repair screen.    Damaged 
systems are repaired in a top-down order. 



Menu Commands
File Menu
xxx Control Menu
Option Menu
Window Menu
? Command
Help Menu
Tactical Popup Menu



File Menu

The File Menu includes commands that enable the player to control the game.

For more information, the user should select the File Menu Command Name:
New
Close
Register
Uninstall
Exit



New

Selecting the New Command from the File Menu will cause a dialog box to be displayed.    The user can 
then restart a game or cancel the new command.    The user can select among three game levels that are 
beginner, normal, and advanced.    The sound may also be set on or off on the dialog box.

A registered customer may also use the game level editor.    This will allow the user to change the game 
level objects.    For example, the user can have a maximum of 99 photons or repair the ship at a rate of 99 
hit points!



Close

Selecting the Close Command from the File Menu will cause the currently active window to close.    The 
windows of the game are hierarchically connected so closing a window may cause other windows to 
close.    The relationship is as follows:

Strategic Display owns:
Tactical Display
Ship Status Display

Also, windows may be closed by using the close command in the window's system menu.



Register

Selecting the Register Command from the File Menu will cause a dialog box to be displayed. The register 
command is used to register the game.

The user should enter his/her name in the name field.    This is used in messages to the user.    The user 
must enter his/her first and last name.

The register dialog box has directions on the steps needed to register the game.    This game must be 
registered after the 15 day trial period.



Uninstall

Selecting the Uninstall Command from the File Menu will cause a message box to be displayed.    The 
user can select YES or NO to uninstall Win Trek. 

The following files are removed from the user's system in the uninstall processing:
* WTREADME.TXT - text file with miscellaneous Win Trek information
* WT.HLP - Win Trek help file
* WT.INI - Win Trek parameter file
* WT.EXE - Win Trek program file

Note: If share is installed in the user's system, Win Trek will encounter an error in the uninstall process.    
Share will not allow a program to access a file that another program is accessing.    Windows is executing 
WT.EXE so the program cannot access it to delete it.    The error message can be ignored and the 
WT.EXE file deleted by hand.



Exit

Selecting the Exit Command from the File Menu will terminate Win Trek.



xxx Control Menu

The Control Menu includes commands that enable a user to issue commands for the currently active 
window.    This game is an MDI windows application.    Therefore, the control's command will have 
different options based on the currently active window.    To make a particular window active, the user 
must either click in the windows or use the window command to select the window.

For more information, the user should select the Control Menu for the particular window:

Strategic Display Window
Scan
Game Status
Ship Status

Tactical Display Window
Launch Wild Weasel
Sensor Overload
Dock
Orbit
Stop

Ship Status Display Window
Repair



Strategic Scan Command

The Scan Command will scan the sectors around the current sector.    The sectors will lose the black null 
indication on the button face for the scanned sectors.    The sectors will indicate the contents by the color 
of the notches in the button.    The Sector Color Code allows a user to determine the contents of a sector 
without entering the sector.



Strategic Game Status Command

The Game Status command will display a dialog box that contains information on the status of the current 
game.    It will display the following information:

Level of game - level of the current game
High Score - highest score yet obtained for the game
Current Score - score of the current game
Starbases - number of starbases in all sectors
Planets - number of planets in all sectors
Enemy Ships - number of enemy ships still remaining



Strategic Ship Status Command

The Ship status command will start the Ship Status window.    It will display all systems of the ship and 
their condition.    While the Ship Status window is active, this command is grayed.



Tactical Release Wild Weasel Command

One Wild Weasel shuttle is carried on all Galaxy class ships.    This shuttle may be released at any time.    
The shuttle will travel to the opposite end of the sector, hopefully leading the enemy away.    The shuttle 
will have enough fuel to operate for about one standard minute.    Only a few Wild Weasels can be carried 
on a ship.    The number of Wild Weasels remaining is displayed on the Ship Status Display.    Shuttles 
can't be stocked at starbases because of space limitations.



Tactical Sensor Overload Command

The sensor array of a Galaxy Class can be overloaded to produce an energy wave of extreme force.    
This wave is strong enough to destroy most ships.    Energy is built-up to a point that the sensor array 
explodes.    This process will destroy parts of the sensor system that cannot be repaired away from a 
starbase.    The resulting power overload will cause great damage to the ship.    The shields will be 
completely destroyed and most of the ship will be damaged.    This is only a LAST ditch option.    A good 
captain would never try this unless it is a matter of life or death.



Tactical Dock Command

The Dock Command will dock the ship at a starbase.    The ship must be close to the starbase to dock.    
Docking will restock the ship with Photon Torpedoes.    The ship will be protected from enemy fire by the 
starbase's shields.    The rate of repair will double in speed.    Also, you can only dock with a starbase 
once per visit to a sector.    It will also replace critical parts destroyed in a sensor overload.



Tactical Orbit Command

The Orbit command will cause the ship to orbit a planet.    The ship must be close to the planet to orbit.    
The ship will be protected from enemy fire by the planet's atmosphere.



Tactical Stop Command

The Stop command will cause the ship to stop all movement.



Ship Status Repair Command

The Repair command is used to indicate which system the user would like repaired next.    Damage 
control will repair the systems in a top-down order.    A dialog box is displayed with all the systems.    The 
undamaged systems are grayed.    The next system to be repaired is selected.    The user may select a 
system to be repaired next by setting the button on the dialog box.



Options Menu

The Option Menu includes commands that enable the user to control options of the game.

For more information, the user should select the Option Menu Command Name:
Sound
Storyline
Bubbles
Pause



Sound Command

The Sound command will turn game sounds on or off.    The state of the sound switch is saved from game 
to game.



Storyline Command

The Storyline command will turn the playing of the game storyline on or off.    The state of the storyline 
switch is saved from game to game.



Bubbles Command

The Bubbles command will turn the automatic display of help bubbles off when playing a beginner level 
game.



Pause Command

The Pause command will pause the current game.    A help button is placed on the dialog box for the user 
to access help.



Window Menu

The Window Menu includes commands that enable the user to control the windows of the MDI 
application.

For more information, the user should select the Option Menu Command Name:
Cascade -- cause windows to be stacked on top of each other.
Tile -- cause windows to be fit next to each other on the main window.
Arrange icons -- arrange iconic windows on the main window.
Close all -- close all windows on the main window.
Windows -- select a window to become active.



? Command

The ? Command will cause informational bubbles to be displayed on all open windows explaining the 
window.    The bubbles are a short and quick form of help.    The bubbles will be erased in a short while.    
The ? Command can be selected again to clear the bubbles.

A game started in beginner mode will automatically have the ? Command displayed at the beginning of 
the game.



Help Menu

The Help Menu includes options that enable the user to get help for the game.

For more information, the user should select the Help Menu Command Name:
Help Index
Using Help
About



Help Index Command

The Help Index command is used to invoke the Windows Help engine.    It will start up with the help index 
for Win Trek.



Using Help Command

The Using Help command will invoke the Windows Help engine.    It will start up with the help for the Help 
engine.



About Command

The About command will display a short dialog box that displays copyright and registration information.    
The More key may be pressed to display a picture of the development team for this software.



Tactical Popup Menu

The Tactical popup menu is used to perform commands on an object in the Tactical window.

For more information, the user should select the Tactical Popup Menu Command Name:
Set New Heading
Fire Phasers
Fire Photons
Scan
cancel this menu



Set New Heading

This command will set a new heading for the player's ship.    The ship will travel to the location set.



Fire Phasers

The Fire Phasers command is selected from the Tactical Popup Menu.    The player's ship will fire its 
phasers at the enemy ship that is nearest to the cursor.    The phasers require a short time to recharge.    
The phasers may be fired as many times as desired.    An enemy ship must be within a short distance 
from the cursor to fire the phasers.



Fire Photons

The Fire Photon Torpedo command is selected from the Tactical Popup Menu.    The player's ship will fire 
a photon torpedo at the enemy ship that is nearest to the cursor.    There is only a limited number of 
photon torpedoes on the ship.    They may be reloaded at a starbase.    An enemy ship must be within a 
short distance from the cursor to fire a photon torpedo.



Scan

The Scan command is selected from the Tactical Popup Menu.    It is used to scan objects in the sector.    
An object must be within a short distance from the cursor to be scanned.    A dialog box will be displayed 
with information about the object and its status.    A plasma torpedo can be scanned to see how much 
power is left.



cancel this menu

This command will cancel the popup menu.



Keyboard

Keyboard commands are shortcuts to the menu options.    All menu options that have keyboard shortcuts 
have the shortcut key listed next to the menu command.    The following is an example: 

Scan 'C' - Scan is the menu command.    Pressing the 'C' key will invoke the Scan command.

Following are the keyboard shortcut commands:
Menu Command Short-cut Key
Strategic Scan 'C'
Strategic Game Status 'G'
Tactical Release Wild Weasel 'W'
Tactical Sensor Overload 'V'
Tactical Dock 'D'
Tactical Orbit 'O'
Tactical Stop 'P'
Tactical Popup Set New Heading 'N'
Tactical Popup Fire Phasers 'A'
Tactical Popup Fire Photons 'T'
Tactical Popup Scan 'S'



Mouse

The mouse has a few special functions in Win Trek.    The functions are different for each window.    
Following are the mouse functions for each window:
Strategic Window
* The left mouse button is used to select the sector the player wishes to warp into.    The sector button is 

single-clicked to activate the warp engines.    Only two sectors can be warped at a time.
Tactical Window
* The left mouse button used to activate the Tactical Popup Menu.    The player moves the cursor on top 

of the object to be processed.    The right mouse button is single-clicked.    The Tactical Popup Menu is 
displayed.    The player may then select the command to be performed on the object.



Win Trek Definitions

Following are the defined terms of the game:
Antimatter
Asteroid
Cloaking Device
Disruptor
Impulse Engines
Ion Storm
MDI
Nebula
Neutron Beam
Phasers
Photon Torpedoes
Plasma Torpedo
Quadrant
Scanners
Sensors
Shields
Starbase
Strategic
Subspace Wrinkle
Super Nova Burst
Tactical
Tractor Repulsor Beam
Warp
Wild Weasel Shuttle
Win Trek
Wormhole



Antimatter

Antimatter is simply the opposite of matter.    In matter, an atom's electrons orbit the nucleus in a 
clockwise motion.    In antimatter, an atom's electrons orbit the nucleus counterclockwise.

Mixing matter and antimatter will cause a very powerful explosion.    A controlled mixture of matter and 
antimatter is the most powerful energy generating system known.



Asteroid Belt

 An asteroid is a large rock floating in space.    These rocks are sometimes as large as small moons.    The 
grouping of asteroids is called an asteroid belt.    Asteroids are harmless to starships.    Starships can pass 
through asteroid belts using navigational force fields to push the asteroids aside.    Some asteroids will 
strike the ship causing damage.



Cloaking Device

A cloaking device is used to camouflage a ship.    It absorbs all types of electromagnetic energy.    This 
causes a ship to become almost invisible to other ships.    It is possible to track a "cloaked" ship but, next 
to impossible to get a lock-on to fire at it.

For some reason, cloaked ships are safe from Natural Disasters.

The Klinions and Romights are the only races to perfect this device.



Disruptor

A disruptor emits a neutron beam that breaks down the molecular bonding between molecules.    This is a 
very short range weapon but, can recharge quickly.



Impulse Engines

Impulse Engines are used to navigate within a sector.    They function by super heating hydrogen gas until 
it changes to plasma.    Then a magnetic field is applied and a large amount of ions is emitted.    These 
ions are used to propel the ship at speeds up to the speed of light.



Ion Storm

An ion storm is caused by certain gases reacting.    These gases cause an electromagnetic reaction that 
will ionize an entire sector.    The ionization of the sector will react with the electronics of a ship.    The 
effect is quite powerful.    It will damage anything in the sector not protected by an atmosphere or starbase 
strength shields.



MDI

MDI stands for Multiple Document Interface.    MDI windows applications have multiple windows contained 
within one main window.    Program Manager or SysEdit are examples of MDI applications.



Nebula

 A nebula is a cloud of super-hot gases.    This cloud of gases will eventually condense to form a star 
system.    Nebulas give off a form of gamma radiation.    The gamma radiation will cause a ship's shields to 
fail.



Neutron Beam

A Neutron Beam is a concentrated beam of super condensed neutrons.    The neutrons are condensed by 
a very powerful force field.    The neutrons are released in an extremely powerful beam.    This beam has 
long range and devastating power.



Phasers

Phasers are a laser-like energy beam.    Phasers use a capacitor to store energy.    The capacitor requires 
time to recharge between firing.    Beginner level player's capacitors recharge faster than advanced.



Photon Torpedo

A Photon Torpedo is a triennium casing containing a small amount of antimatter.    There is a force field 
that contains the antimatter.    When the torpedo reaches its destination, the force field is dropped and a 
powerful explosion is created.    Galaxy class ships can only hold a few Photon Torpedoes.    Beginner 
level players receive more than advanced.



Plasma Torpedo

A Plasma Torpedo is a small, sublight torpedo containing a plasma impulse engine.    It takes a large 
amount of energy to charge the plasma torpedo.    Therefore, the firing rate is slow.    The plasma torpedo 
depletes its plasma fuel as it chases the target.    At short range they are deadly.    It is difficult to out run 
plasma torpedoes.    They are faster than ships.    A plasma torpedo can be detonated by firing on it.



Quadrant

A quadrant is the section of the universe that a starship is assigned.    This is also the range of the 
scanners.    Quadrants are made up of sectors.    The Strategic Display is the display of the quadrant.



Scanners

Scanners are a ship's long range sensing equipment.    They are used to scan the surrounding sectors of 
a ship's current location.    Once a sector is scanned, its contents are recorded in the scanner's database. 
This database of information is displayed on the Strategic Display.    When scanners are destroyed, the 
record of scanned sectors is lost.



Sector

A sector is the smallest subdivision of the universe.    Sectors are the tactical portion of space.    The 
tactical display is the view of a sector.    Quadrants are made up of sectors.



Sensors

Sensors are a ship's short range sensing equipment.    They are used to scan objects within a sector.    
They can be used to scan ships.    The sensors also aid the fire control computers to lock-on to a target.    
When the sensors are damaged, the effectiveness of weapons is reduced by 50%.    A sensor overload 
can also be created to help a ship in a bad situation.



Shields

Shields are a force field of plasma energy that will absorb energy.    The shields of a ship will protect it 
from enemy fire.    The energy absorption level of a ship is finite.    After the shields have a certain level of 
energy, they become damaged.

Shields also have a repulsor beam that is used to protect a ship from solid matter such as meteoroids.



Starbase

 A starbase is an oasis in the far reaches of the universe.    These are very large, stationary spaceships.    
They are equipped with supplies and very strong shields.    Starbases will protect a docked ship.    They 
also will allow a ship to repair itself twice as fast as normal.    Photon torpedoes are restocked when 
docking.    The base commander will only allow one docking per visit to a sector.



Strategic

Strategic is a term used to define an overall long range look at a situation or problem.    In Win Trek the 
Strategic Display window shows the sectors of the quadrant.    From this display, the player can plan the 
conquest of the sectors.



Subspace Wrinkle

A subspace wrinkle is a pocket of antimatter that has naturally formed.    The antimatter will cause a small 
warp field.    When an object enters the warp field, it is moved to a new location.    The distance is very 
short.    It will not move a ship out of a sector.    Antimatter is very unstable.    After the ship leaves the warp 
field, the antimatter will disintegrate.



Super Nova Burst

A super nova is a neutron star.    It emits pulses of energy at certain times.    The energy is quite powerful. 
It will damage anything in the sector not protected by an atmosphere or starbase strength shields.



Tactical

Tactical is a term used to define a close-up or short range look at a situation or problem.    In Win Trek, the 
Tactical Display window shows the current sector where the player's ship is located.    This is where the 
player does most of the "work".    The enemy ships are engaged here.    The player docks with starbases 
to restock and to take a rest.



Tractor Repulsor Beam

A Tractor Repulsor Beam is a very advanced form of a Tractor Beam.    This weapon can switch from pull 
to push at a microsecond rate.    This will virtually shake the target apart.    It has a very long range.    It 
takes a long time to build the energy needed to fire this weapon.



Warp

Warping is a term for time space travel.    Since it is impossible to travel faster than the speed of light, 
another type of travel is needed.    It was determined that a starship could create a warp field that will 
cause a ship to alter the time-space continuum.    This allows the ship to "warp" to a new location without 
really moving.    This process requires a large amount of energy.    A matter/antimatter engine provides 
power for the warping process.



Wild Weasel Shuttle

A Wild Weasel shuttle is a decoy shuttle.    This shuttle is very heavily loaded with electronic counter-
measure equipment.    This equipment is used to create a simulation of the ship that launched the shuttle. 
To any ship in the sector, the shuttle will appear to be the ship.    The shuttle also has a very large shield 
generator to protect it while operating.    The shuttle uses an impulse engine operating on overload to 
achieve the level of energy needed.    The impulse engine will burn out in about a standard minute.    The 
shuttle cannot be recovered.



Win Trek

Win Trek is a copyrighted game created by BFM Software.
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Wormhole

A wormhole is a time-space inter-dimensional connection.    It will instantly transport an object great 
distances.    Wormholes are undetectable until they are encountered, then it is too late!    They will move a 
ship many sectors.    Their appearance is random.    They do not cause damage to the ship.




